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Welcome 
Welcome to the Columbia Weather Systems family of users and 
congratulations on your purchase of WeatherMaster software. 
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Introduction 

Features 
 Compatible with Capricorn 2000/2000EX, Capricorn FLX, Pegasus, 

Orion, Vela, Magellan, Magellan MX, Pulsar LX (Pulsar with 
MicroServer), Weather MicroServer and CWS Web XML data. 

 Collects data from single or multiple weather stations connected to 
separate COM ports on the computer, or through network 
connection.  

 Displays data using multiple HTML pages. 
 Automatically updates a web page for each station using an HTML 

template. 
 Automatically generates a data export file to upload to an FTP server 

for each station. 
 Displays trend chart, daily statistics, monthly statistics and latest 

measurements for each station. 
 Allows historical data to be viewed in trend, and daily/monthly 

statistics pages.  
 Emails detailed weather report. 
 Provides flexible alarm conditions for individual stations. 
 Allows multiple alarm conditions and notifications. 
 Alarm notifications include popup, email, and relay control. 
 Allows for user defined wind direction offset 
 Interfaces with ALOHA software*. 
 Stores data in an SQL Database. 
 Allows for flexible data export from database. 
 Uploads weather data to Weather Underground 
 Captures serial data to a CSV file 
 
* Area Locations of Hazardous Atmospheres Software 
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Installation 

Software Installation 
Insert the “credit card” USB Drive into a USB port on the computer. Open 
the USB Drive folder and double click on the SetupWM.exe file to start 
the installation. 

Follow the on-screen instructions to complete the installation. 

 

The minimum computer requirements for WeatherMaster software are: 

• Windows 7 or 10 operating system 

• Intel Core i3 or equivalent 

• 4MB Memory 

• 500MB Hard Drive 

• Serial port or USB to Serial Converter 
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Configuration 

Weather Stations 
From the Configuration menu, select Weather Stations. 
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Adding a new station 
To add a new station, select the Add button in the Weather Stations 
dialog. 

MicroServer, Web XML, and File XML Site 
Station Types 
The MicroServer station communicates with WeatherMaster via the 
Ethernet network using XML data. 

The Web XML station communicates with WeatherMaster via the 
Internet using XML data which is exported to the Internet by the 
MicroServer every 15 seconds. 

The File XML station communicates with WeatherMaster via the Network 
using XML data which is exported to the Internet by the MicroServer 
every 15 seconds. 

 

Station ID: 

For the MicroServer station, enter the serial number of the MicroServer. 

For Web and File XML stations, enter 100 as the serial number. If adding 
more than one station, increment the serial number. 

Description: 

Enter a description for the weather station location, such as Main Street, 
Hillsboro, North Runway, Command Center or any other description 
desired. 
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Station Type: 

For MicroServer stations, enter the MicroServer IP address (found on 
the side of the MicroServer enclosure). 

For Web XML stations, enter the web address and xml file name, e.g. 
www.columbiaweather.com/commandcenter.xml. 

For File XML stations, enter the path and XML file name, e.g. 
C:\Documents and Settings\weather.xml 

 

Check “Interface to Aloha” to interface WeatherMaster with ALOHA 
(Area Locations of Hazardous Atmospheres) software. If there are 
multiple weather stations communicating with the software, only the first 
station defined will communicate with ALOHA software.  

WeatherMaster communicates directly with ALOHA software using the 
NOAA_32.DLL library file. 

WeatherMaster can also output the ALOHA SAM data over a serial com 
port. This feature is used by other third-party software that expects the 
ALOHA SAM data over a serial com port. 

Use the Add button to add more stations as required. 

Click OK when finished to save changes. 

Click Cancel to close the dialog without saving changes. 
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Reset Measurements List 

If the Selected Measurements list is changed in the MicroServer then 
WeatherMaster can be updated to reflect this change.  

 

To update WeatherMaster with the new measurements click Edit from 
the Configuration/Weather Stations screen.  

On the Measurements tab click Reset Measurement List.  
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If any custom sensors have been added to the MicroServer they can be 
saved to the database by checking the corresponding measurement 
under Additional Measurements. 

Click Apply Changes to save the changes.  
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Orion, Magellan, Magellan MX and 
Capricorn FLX Station Types 
The Orion, Magellan, Magellan MX and Capricorn FLX weather stations 
communicate with WeatherMaster via an RS-232 serial communication 
port (Comm. Port). 

If the computer does not have a built-in serial port, a USB to Serial 
converter can be used to create a virtual serial port. 

 

Station ID: 

For Orion Serial, Magellan Serial and Magellan MX Serial enter 100 as 
the serial number. If adding more than one station, increment the serial 
number. 

For Capricorn FLX stations, enter the Control Module serial number.  

Description: 

Enter a description for the weather station location, such as Main Street, 
Hillsboro, North Runway, Command Center or any other description 
desired. 

Station Type: 

Select the appropriate station type: Orion Serial, Magellan Serial, 
Magellan MX Serial or Capricorn FLX. For Vela weather stations, select 
the Magellan Serial setting. 

Select the Comm. Port the station is connected to from the drop-down 
list. 

Click OK.  
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Station Settings 
To edit the station settings click Edit from Weather Station dialog.  

 

 

Location description and port settings can be edited. 

Barometric Pressure Offset: is the barometric pressure calibration offset. 
For example: 56 pressure offset will increase the barometric pressure 
reading by 0.56 in Hg. 

Altitude: is the elevation of the site being monitored. 0 ft is the default 
value set at the factory. This value should be changed to reflect the 
correct altitude of the site. The altitude setting will affect the barometric 
pressure reading. An increase of 10 feet will increase the pressure 
reading by 0.01 in Hg. 

Rain for the year offset: is used to correct the rainfall amount for the 
year. 

Wind Direction Offset: Allows the user to enter a degree offset to change 
the wind direction value. This feature is useful for vehicle or boat 
mounted systems. The offset is added to the actual wind direction value. 
For example, if the sensor output is 45º and the offset is 10º, then 
WeatherMaster will display 55º for the wind direction value. 

For the Magellan MX501 click Sensors and check Solar Radiation.   
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Capricorn/Pegasus Station Type 
Select the Edit button from the Weather Station dialog to change the 
station configuration. 

 

Location description and port settings can be edited. 

If using evapotranspiration, enter the appropriate crop factor. Crop factor 
1 is for a reference crop of Alfalfa.  

Evapotranspiration is calculated using the 1982 Kimberly-Penman 
formula as applied in the U.S. Bureau of Reclamation’s Pacific Northwest 
AgriMet Program. 

Note: In order to correctly calculate evapotranspiration, the following 
sensors must be installed in the system: 

 Air temperature 

 Wind speed and direction 

 Relative humidity 

 Solar radiation 

If using Degree-Day, enter the reference temperature to be used in the 
calculations. The Degree-Day reference temperature must be entered in 
degrees F. 
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Degree-Day = Average Temperature – Reference Temperature 

Reference temperature varies from one application to another. 

Enter the start date for Degree-Day accumulation. 

Degree-Day accumulation for the season (from the start date) is 
displayed in the Temperature/Rain and Daily Statistics screens. 

Wind Direction Offset: Allows the user to enter a degree offset to change 
the wind direction value. This feature is useful for vehicle or boat 
mounted systems. The offset is added to the actual wind direction value. 
For example, if the sensor output is 45º and the offset is 10º, then 
WeatherMaster will display 55º for the wind direction value. 

Sensors  
In the Edit Weather Station dialog, select the Sensors tab. 

 

Select the sensors that are installed in the weather station. 

If temperature 1 is not selected, then wind chill, dew point and heat index 
will not be displayed. 

If relative humidity is not selected, then dew point, and heat index will not 
be displayed 

Note: Wind speed, wind direction, and barometric pressure are always 
enabled in the software. 
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Define the sensors connected to multi-purpose channels, X1 and X2. 
These channels are only available with the Capricorn 2000MP and 
Capricorn 2000EX. Normally solar radiation is connected to X1 and soil 
moisture is connected to X2. If there aren’t any sensors connected to 
these channels, X1 and X2 sensor entries should be left blank. 

Reset Sensors: Click on this button to re-initialize Temperature 1 sensor. 
This feature is only applicable for weather stations with a single 
temperature sensor. 

Station Properties  
In the Edit Weather Station dialog, select the Station Properties tab. 

 

The dialog will display all sensor calibration offsets and internal settings 
of the weather station. These settings are pre-configured at the factory. 

To change any of these settings, simply highlight the desired value and 
type in the new value. 

T1 through T4 Offsets: are the temperature calibration offsets found on 
the temperature probe cables in Capricorn or Pegasus weather stations. 
For the Orion weather station, T1 is the only relevant temperature offset. 
This offset can be used to adjust the temperature reading if desired.  
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Pressure Offset: is the barometric pressure calibration offset. For 
example: 56 pressure offset will increase the barometric pressure 
reading by 0.56 in Hg. 

Altitude: is the elevation of the site being monitored. 0 ft is the default 
value set at the factory. This value should be changed to reflect the 
correct altitude of the site. The altitude setting will affect the barometric 
pressure reading. An increase of 10 feet will increase the pressure 
reading by 0.01 in Hg. 

Hi/Lo Interval: This setting determines how often a high (maximum) and 
low (minimum) record is stored in the data log of the Control Module.  

Logging Interval: This setting determines how often a current value 
record of all sensors is stored in the data log of the Control Module.  

Select Save to Weather Station to save the changes without exiting the 
dialog. 

After changing the settings, select OK and the software will send the new 
values to the Control Module. 

Selecting Cancel will close the dialog without any changes taking effect. 

Please refer to the Weather Station User Manual for more information 
about calibration and settings values. 
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Data Logging 
To import data from a Capricorn or Pegasus weather station select the 
Data Logging tab in the Edit Weather Station dialog. 

 

Check Delete data log after reading if you want to delete the data log 
from the Control Module. Otherwise leave it unchecked. 

Note: If the Control Module is also connected to other devices such as a 
modem or other computers, deleting the data log will prevent the other 
devices from accessing the data. 

Downloading a full data log will take about 1 to 2 minutes. The 
downloaded data will be incorporated into the software database. 

To change the data log recording intervals, please refer to the Station 
Properties section above. 

Click on Import Data Log Now to import the data log from the 
Capricorn/Pegasus Control Module. 

When the import is completed, the software will display a window with 
the number of records imported. Click OK to close. 

 



WeatherMaster 25 
 ________________________________________________________________________  

Columbia Weather Systems, Inc. 

Capricorn FLX Station Type  
Select the Edit button from the Weather Station dialog to change the 
station configuration. 

 

 

Location description and port settings can be edited. 

Barometric Pressure Offset: is the barometric pressure calibration offset. 
For example: 0.02 pressure offset will increase the barometric pressure 
reading by 0.02 in Hg. 

Altitude: is the elevation of the site being monitored. 0 ft is the default 
value set at the factory. This value should be changed to reflect the 
correct altitude of the site. The altitude setting will affect the barometric 
pressure reading. An increase of 10 feet will increase the pressure 
reading by 0.01 in Hg. 

Rain for the year offset: is used to correct the rainfall amount for the 
year. 

Wind Direction Offset: Allows the user to enter a degree offset to change 
the wind direction value. This feature is useful for vehicle or boat 
mounted systems. The offset is added to the actual wind direction value. 
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For example, if the sensor output is 45º and the offset is 10º, then 
WeatherMaster will display 55º for the wind direction value. 

Sensors 
In the Edit Weather Station dialog, select the Sensors tab. 

 

 

Select the sensors that are installed in the weather station. 
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XML Output 
WeatherMaster is able to output the current weather data in an XML file 
format. 

In the Edit Weather Station dialog (any station type), click on the Change 
button in the XML Data Output box. 

 

Check “Output XML data to file” box to enable the feature. 

Browse and select the location and enter a file name. 

The XML File will reflect the parameters available for the station type 
selected and it has the following format: 

<oriondata station=""><meas name="time-of-day" updateTS="2018/12/04 15:13:01">2018/12/04 
15:13:01 

</meas><meas name="inst-wind-speed" updateTS="2018/12/04 15:13:01">7.2</meas> 

<meas name="inst-wind-dir" updateTS="2018/12/04 15:13:01">30</meas> 

<meas name="rel-humidity" updateTS="2018/12/04 15:13:01">45</meas> 

<meas name="barom-press" updateTS="2018/12/04 15:13:01">30.14</meas> 

<meas name="temp" updateTS="2018/12/04 15:13:01">45.6</meas> 

<meas name="wind-chill" updateTS="2018/12/04 15:13:01">41.8</meas> 

<meas name="heat-index" updateTS="2018/12/04 15:13:01">46.0</meas> 

<meas name="dew-point" updateTS="2018/12/04 15:13:01">25.5</meas> 

<meas name="degree-day" updateTS="2018/12/04 15:13:01">6141.4</meas> 

<meas name="rain-today" updateTS="2018/12/04 15:13:01">0.000</meas> 

<meas name="rain-this-week" updateTS="2018/12/04 15:13:01">0.002</meas> 

<meas name="rain-this-month" updateTS="2018/12/04 15:13:01">0.032</meas> 

<meas name="rain-this-year" updateTS="2018/12/04 15:13:01">19.337</meas> 

<meas name="rain-rate" updateTS="2018/12/04 15:13:01">0.00</meas> 

<meas name="density-altitude" updateTS="2018/12/04 15:13:01">-817</meas> 

<meas name="2min-rolling-avg-wind-speed" updateTS="2018/12/04 15:13:01">5.4</meas> 
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<meas name="2min-rolling-avg-wind-speed_2" updateTS="2018/12/04 15:13:01">0.0</meas> 

<meas name="2min-rolling-avg-wind-dir" updateTS="2018/12/04 15:13:01">49</meas> 

<meas name="2min-rolling-avg-wind-dir_2" updateTS="2018/12/04 15:13:01">0</meas> 

<meas name="10min-rolling-avg-wind-speed" updateTS="2018/12/04 15:13:01">4.1</meas> 

<meas name="10min-rolling-avg-wind-speed_2" updateTS="2018/12/04 15:13:01">0.0</meas> 

<meas name="10min-rolling-avg-wind-dir" updateTS="2018/12/04 15:13:01">45</meas> 

<meas name="10min-rolling-avg-wind-dir_2" updateTS="2018/12/04 15:13:01">0</meas> 

<meas name="windrun" updateTS="2018/12/04 15:12:48">49.00</meas> 

<meas name="vmean-windrun" updateTS="2018/12/04 15:12:48">3.71</meas> 

<meas name="vmean-winddir" updateTS="2018/12/04 15:12:48">239</meas> 

<meas name="vmean-winddirstddev" updateTS="2018/12/04 15:12:48">40</meas> 

<meas name="2min-gust-windspeed" updateTS="2018/12/04 15:13:01">12.6</meas> 

<meas name="2min-gust-windspeed_2" updateTS="2018/12/04 15:13:01">0.0</meas> 

<meas name="2min-gust-winddir" updateTS="2018/12/04 15:13:01">2</meas> 

<meas name="2min-gust-winddir_2" updateTS="2018/12/04 15:13:01">0</meas> 

<meas name="10min-peak-windspeed" updateTS="2018/12/04 15:13:01">12.6</meas> 

<meas name="10min-winddir-atpeak" updateTS="2018/12/04 15:13:01">2</meas> 

<meas name="60min-peak-windspeed" updateTS="2018/12/04 15:13:01">12.9</meas> 

<meas name="60min-winddir-atpeak" updateTS="2018/12/04 15:13:01">49</meas> 

<meas name="solar-radiation" updateTS="2018/12/04 15:13:01">0</meas> 

<meas name="raw-barom-pressure" updateTS="2018/12/04 15:13:01">29.92</meas> 

<meas name="raw-inst-wind-dir" updateTS="2018/12/04 15:13:01">30</meas> 

<meas name="wet-bulb-globe-temp" updateTS="2018/12/04 15:13:01">50.1</meas> 

<meas name="saturated-vapor-pressure" updateTS="2018/12/04 15:13:01">0.31</meas> 

<meas name="vapor-pressure" updateTS="2018/12/04 15:13:01">0.14</meas> 

<meas name="dry-air-pressure" updateTS="2018/12/04 15:13:01">29.78</meas> 

<meas name="dry-air-density" updateTS="2018/12/04 15:13:01">0.0782</meas> 

<meas name="absolute-humidity" updateTS="2018/12/04 15:13:01">0.0002</meas> 

<meas name="air-density-ratio" updateTS="2018/12/04 15:13:01">1</meas> 

<meas name="adjusted-altitude" updateTS="2018/12/04 15:13:01">-702</meas> 

<meas name="SAE-correction-factor" updateTS="2018/12/04 15:13:01">0.95</meas> 

<meas name="wet-air-density" updateTS="2018/12/04 15:13:01">0.0784</meas> 

<meas name="wet-bulb-temp" updateTS="2018/12/04 15:13:01">36.6</meas> 

<meas name="hail-rate" updateTS="2018/12/04 15:13:01">0</meas> 

<meas name="hail-today" updateTS="2018/12/04 15:13:01">0</meas> 

</oriondata>        
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Display Units  
Select Options>Units 

Units of Measurements 
To set the unit of measurement, select Units from the Options menu list. 

 

In the Units tab select the desired units for the temperature, wind, 
pressure, and rainfall parameters. 

The temperature unit selection will apply to all temperature readings, 
wind chill, heat index, dew point, and degree day. 

The rainfall unit selection will apply to all rain values and 
evapotranspiration. 
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Export Setup 
From the Configuration menu, select Auto Setup. 

CSV Data Export 
To configure WeatherMaster to export text data to a local computer or 
the Internet, select the CSV Data Export tab from the Export Setup 
dialog. 

Please note the Data Export feature will report in U.S. Customary units. 
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Check the Enable Automatic Export box if you want WeatherMaster to 
automatically export the data. Select the desired export interval. The 
minimum interval is 5 minutes. 

Select the amount of data to be included in the text file by specifying the 
data period in hours. The minimum data period is one hour and the 
maximum period is 24 hours. 

Check the Export Column Name as First Line box if you would like 
WeatherMaster to include the column names in the first line. 

Select the data destination, local computer or FTP Host (Internet). 

If local computer is selected, enter the path of the directory (or folder) 
where the file will be saved. If the path is left blank, the file will be saved 
in the program folder. 

If FTP Host is selected, enter the FTP connection information. This 
information can be obtained from the FTP host provider. 

Manual Data Export 
To manually export text data, click Export CSV Now. 

WeatherMaster will start the export process based on the setup in the 
Data Export dialog. 
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Data File Format 
The first line of the data file may be a comma-delimited list of the field 
names, in the order represented by the values in each record. This line is 
optional. The rest of the file consists of comma delimited data records. 
Below is a sample of an output file with one record. 

STATIONNAME,time-of-day,inst-wind-speed,inst-wind-speed_2,inst-
wind-dir,rel-humidity,barom-press,barom-press_2,barom-
press_3,temp,temp_2,temp_3,temp_4,wind-chill,heat-index,dew-
point,rain-today,rain-rate,density-altitude,2min-rolling-avg-wind-
speed,2min-rolling-avg-wind-dir,10min-rolling-avg-wind-speed,10min-
rolling-avg-wind-dir,2min-gust-windspeed,2min-gust-winddir,60min-
peak-windspeed,60min-winddir-atpeak,solar-radiation,solar-
radiation_2,visibility,raw-barom-pressure_2,raw-barom-
pressure_3,wet-bulb-globe-temp,saturated-vapor-pressure,vapor-
pressure,dry-air-pressure,dry-air-density,absolute-humidity,air-density-
ratio,wet-air-density,wet-bulb-temp,lux,60min-rolling-avg-wind-
speed,60min-rolling-avg-wind-dir,uv-radiation,particle-concent,3sec-
rolling-avg-wind-speed,3sec-rolling-avg-wind-dir 

W5291,12/5/2018 7:53:27 
AM,8.7,0,34,61,30.11,0,0,37.4,0,0,0,31,37,25.1,0,0,-
1347,6.6,9,4.3,43,11.6,355,17.3,11,0,0,0,0,0,45.4,0.22,0.14,29.75,0.079
4,0.0002,1,0.0796,31.1,0,4.6,46,0,0,7.8,13 

One output file is generated for each weather station with the name 
nnntrh.txt, where nnn is the station ID for the given station.  
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HTML Export 
To configure WeatherMaster to export an HTML file to a local computer 
or the Internet, select the HTML Export tab from the Export Setup dialog. 

 

Check the Enable Automatic Export box, if you want WeatherMaster to 
automatically export the data. Select the desired export interval. The 
minimum interval is 5 minutes. 

Select the amount of data to be included in the text file by specifying the 
data period in hours. The minimum data period is one hour and the 
maximum period is 24 hours. 

Check the Export Column Name as First Line box if you would like 
WeatherMaster to include the column names in the first line. 
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Select the data destination, local computer or FTP Host (Internet). 

If local computer is selected, enter the path of the directory (or folder) 
where the file will be saved. If the path is left blank, the file will be saved 
in the program folder. 

If FTP Host is selected, enter the FTP connection information. This 
information can be obtained from the FTP host provider. 

Manual HTML Export 
To manually export the HTML file, click Export HTML Now. 

WeatherMaster will start the export process based on the setup in the 
HTML Export dialog. 

HTML Template Format 
HTML Export requires customizing the file <sample.html>, which can be 
found in the directory where WeatherMaster is installed. Sample.html is 
an HTML file, in which special tags are replaced with the current 
parameter readings from weather stations. Values will be entered in the 
units specified in the WeatherMaster Display Options. One output file is 
generated for each weather station in the form of nnnsample.html, where 
nnn is the station serial number for the given station. The output files are 
optionally uploaded to an FTP server.  

Parameter HTML Tag 

Date <#Date Format="mm/dd/yyyy"> 

Last Sample timestamp <#Time_of_day> 

Wind Speed <#inst_wind_speed> 

Wind Direction <#inst_wind_dir> 

3-sec Wind Speed Average <#_3sec_gust_wind_speed> 

3-sec Wind Direction Average <#_3sec_gust_wind_dir> 

2-min Wind Speed Average <#_2min_rolling_avg_wind_speed> 

2-min Wind Direction Average <#_2min_rolling_avg_wind_dir> 

10-min Wind Speed Average <#_10min_rolling_avg_wind_speed> 

10-min Wind Direction Average <#_10min_rolling_avg_wind_dir> 

10-min Wind Speed Peak <#_10min_peak_windspeed> 

Wind Direction at 10-min Wind 
Speed Peak 

<#_10min_winddir_atpeak> 

60-min Wind Speed Peak <#_60min_peak_windspeed> 
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Wind Direction at 60-min Wind 
Speed Peak 

<#_60min_winddir_atpeak> 

Wind Run <#windrun> 

Vector Mean Wind Speed <#vmean_windrun> 

Vector Mean Wind Direction <#vmean_winddir> 

Vector Mean Wind Direction 
Standard Deviation 

<#vmean_winddirstddev> 

Air Temperature <#temp1> 

Temperature 2 <#temp2> 

Temperature 3 <#temp3> 

Temperature 4 <#temp 4> 

Relative Humidity <#rel_humidity> 

Barometric Pressure <#barom_press> 

Raw Barometric Pressure <#raw_barom_pressure> 

Density Altitude <#density_altitude> 

Wind Chill <#wind_chill> 

Heat Index <#heat_index> 

Dew Point <#dew_point> 

Wet Bulb Globe Temperature <#wet_bulb_globe_temp> 

Wet Bulb Temperature <#wet_bulb_temp> 

Degree Day <#degree_day> 

Rain for the Day <#rain_today> 

Rain for the Week <#rain_this_week> 

Rain for the Month <#rain_this_month> 

Rain for the Year <#rain_this_year> 

Rain Rate <#rain_rate> 

Solar Radiation <#solar_radiation> 

Saturated Vapor Pressure <#saturated_vapor_pressure> 

Vapor Pressure <#vapor_pressure> 

Dry Air Pressure <#dry_air_pressure> 

Dry Air Density <#dry_air_density> 
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Wet Air Density <#wet_air_density> 

Absolute Humidity <#absolute_humitiy> 

Air Density Ratio <#air_density_ratio> 

Adjusted Altitude <#adjusted_altitude> 

SAE Correction Factor <#SAE_correction_factor> 

Extinction Coefficient <#extinction_coefficient> 

Lux meter <#lux> 

Day/Night <#day_night> 

Wind Speed 2 <#wind_speed_2> 

Raw Wind Direction 2 <#raw_wind_dir_2> 

3-sec Wind Speed Average 2 <#_3sec_gust_wind_speed_2> 

3-sec Wind Direction Avg 2 <#_3sec_gust_wind_dir_2> 

2-min Wind Speed Average 2 <#_2min_rolling_avg_wind_speed_2> 

2-min Wind Direction Avg 2 <#_2min_rolling_avg_wind_dir_2> 

10-min Wind Speed Avg 2 <#_10min_rolling_avg_wind_speed_2> 

10-min Wind Direction Avg 2 <#_10min_rolling_avg_wind_dir_2> 

10-min Wind Speed Peak 2 <#_10min_peak_windspeed_2> 

Wind Direction at 10-min Wind 
Speed Peak 2 

<#_10min_winddir_atpeak_2> 

60-min Wind Speed Peak 2 <#_60min_peak_windspeed_2> 

Wind Direction at 60-min Wind 
Speed Peak 2 

<#_60min_winddir_atpeak_2> 

Soil Moisture <#soil_moisture> 

Leaf Wetness <#leaf_wetness> 

Evapotranspiration <#et> 
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Note: Some HTML tags are not available for certain station types. 

To have the date or time included, use these tags: 

<#Date> 

<#Time> 

You can optionally include a Format=”***” parameter in the #Date or 
#Time tag. The Format string is used to program the exact type of date 
or time format desired. Here are some samples: 

<#Date Format=”mm/dd/yyyy”> 

<#Time Format=”tt”> 

The following is a complete list of options for date/time Format strings: 

Specifier Displays 
nd Displays the day as a number without a leading zero 

(1-31). 
dd Displays the day as a number with a leading zero (01-

31). 
ddd Displays the day as an abbreviation (Sun-Sat) using 

the strings given by the ShortDayNames global 
variable. 

dddd Displays the day as a full name (Sunday-Saturday) 
using the strings given by the LongDayNames global 
variable. 

m Displays the month as a number without a leading 
zero (1-12). If the m specifier immediately follows an h 
or hh specifier, the minute rather than the month is 
displayed. 

mm Displays the month as a number with a leading zero 
(01-12). If the mm specifier immediately follows an h 
or hh specifier, the minute rather than the month is 
displayed. 

mmm Displays the month as an abbreviation (Jan-Dec) 
using the strings given by the ShortMonthNames 
global variable. 

mmmm Displays the month as a full name (January-
December) using the strings given by the 
LongMonthNames global variable. 

yy Displays the year as a two-digit number (00-99). 
yyyy Displays the year as a four-digit number (0000-9999). 
h Displays the hour without a leading zero (0-23). 
hh Displays the hour with a leading zero (00-23). 
n Displays the minute without a leading zero (0-59). 
nn Displays the minute with a leading zero (00-59). 
s Displays the second without a leading zero (0-59). 
ss Displays the second with a leading zero (00-59). 
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am/pm Uses the 12-hour clock for the preceding h or hh 
specifier, and displays 'am' for any hour before noon, 
and 'pm' for any hour after noon. The am/pm specifier 
can use lower, upper, or mixed case, and the result is 
displayed accordingly. 

a/p Uses the 12-hour clock for the preceding h or hh 
specifier, and displays 'a' for any hour before noon, 
and 'p' for any hour after noon. The a/p specifier can 
use lower, upper, or mixed case, and the result is 
displayed accordingly. 

/ Displays the date separator character given by the 
DateSeparator global variable. 

: Displays the time separator character given by the 
TimeSeparator global variable. 

Sample.html file can be modified/customized by the user to fit the look 
and feel of an existing web site. 
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Alarms 
WeatherMaster has the capability of setting an unlimited number of 
alarm conditions with each alarm having one or more notification 
method. 

To view the alarms dialog, select Alarms from the Options menu. 

Alarm Conditions 

 

To define an alarm condition, select the Add button under the Alarm 
Conditions window. 
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Enter a descriptive name for the alarm and select OK. 

The alarm condition name will be listed in the Alarm Conditions window. 

Select the name of the parameter. 

Define the upper and/or lower limits. 

Notifications 
WeatherMaster allows an unlimited number of notifications, which can be 
shared by multiple alarms. 

To define a notification, select the Add button at the bottom of the 
Notifications window. 

There are three types of notifications available: 

Popup Notification 
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Enter a descriptive name for this notification and select Popup Only. 

A Popup notification will cause the computer to sound a tone when the 
alarm conditions are met. 

Email Notification 

 

Enter the descriptive name for this notification and select Email. 

Enter the Sender Name. This should be the name of the person using 
WeatherMaster. 

Enter the Sender Email. This should be the email address of the person 
using WeatherMaster. 

Enter a subject line that WeatherMaster can use in the email. 

Enter the email address of the recipient. This can be the same as the 
sender’s email address, if the sender wishes to be notified. 

Enter the name of the Mail Server. To get the name of the server:  

1. From the Windows Start button, select Settings, then select Control 
Panel. 

2. In the Control Panel window, double click on the Mail icon. 

3. Select your email service and click on the Properties button. 

4. Select the Servers tab to view the name of the mail server next to the 
Outgoing Mail (SMTP). 
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Click OK to close this window and save any changes. 

Click Cancel to close the window and discard any edits. 

Relay Control Notification 

 

The Relay Control notification feature is available in WeatherMaster with 
the addition of a USB 4 channel Relay Controller. Please contact 
Columbia Weather Systems for more information. 

Enter a descriptive name for this notification and select Relay Control. 

Select the desired relay to activate. Four relays are available, K0 through 
K3. 

Once an alarm condition is met, the selected relay will close 
momentarily. 

The Relay Controller is designed to activate a secondary latch relay with 
a user selectable timer.  

Click OK to close the Notification window and save any changes. 

Click Cancel to close the window and discard any edits. 
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Alarm Condition 
Once an alarm condition has occurred, an Alarm Condition window will 
appear on the screen with a list of alarms that have occurred listing the 
date and time, name of the notification, name of the alarm, the value of 
the parameter and which limit has been violated. 

 

 

The software will continue to display this screen until the user clicks on 
the OK button to acknowledge the alarm information. 
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Email Report 
WeatherMaster has the capability of sending an email report at a user 
selectable interval to multiple email addresses. 

The email message can also be sent as a cell phone text message by 
simply emailing the cell phone. For a cell phone email address, please 
visit the cell phone service provider’s web site. 

To view the Email Notification dialog, select Email Report from the 
Option menu. 

 

Select the desired weather station. Use the drop-down if you have 
multiple weather stations defined in WeatherMaster. 

Check the “Enable Email Report for this station”. 

Select the email report interval. Minimum interval is 5 minutes. 

Enter the sender name, sender email, and subject line. 

Enter the recipient’s email address. Use a semi colon to separate 
multiple email addresses. 

Enter the outgoing mail server (SMTP) used by the computer. This 
information can be found in the Control Panel/Mail/Email Account. 

Check “Mail server uses authentication” if your email service requires 
authentication. Enter the user and password required. 
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Select the measurements to add to the report. The Report Preview will 
display the selected parameters and their current values. 

If you are sending the report to a cell phone, you can check the Use 
Short Names to abbreviate the parameter names. Cell phone text 
messages have a 150-character limitation. 

Use the Send Test Email button to send a test Email Report. 

Click OK to apply the changes and close the dialog. 

 

Weather Underground 
WeatherMaster can upload the weather data to a Weather Underground 
account.  
 

 
 
First create an account by visiting Weather Underground at 
https://www.wunderground.com/signup 
 
To enable the feature in WeatherMaster click Weather Underground from 
the Options menu. Enter your Weather Underground Station ID and 
password. 
 
WeatherMaster uploads the weather data every 5-minutes to Weather 
Underground. 
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Data 

MicroServer Data Synchronization 
If WeatherMaster software is communicating with a MicroServer, it will 
automatically synchronize the database with the data log files stored in 
the MicroServer. If WeatherMaster is closed it will begin the 
synchronization process (in the background) when WeatherMaster is 
reopened. When the process is done the following window will appear: 

 

Click OK to close. 

Export Trend Data 
Select Data/Export Trend Data 
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Select the Export Data Range. The dialog offers the following predefined 
data ranges: 

Today, Yesterday, Last 2 Days, and Current Month. 

You can also select Custom Date Range to define your own date range. 

If Custom Date Range is selected, enter the Start and End dates in the 
new fields on the right side of the dialog. 

Select the desired Measurements. Use the Select All button if all 
measurements are required. 

Select the Output Units. 

Enter the Export File name and path. Click on the Browse button to 
choose the folder. 

Click on Export Data when ready. 

When the export is completed, a window will appear stating: 

Successfully exported data from station name and serial number. 

Click OK to close it. 

The Export Data Trend dialog will export all the selected parameters in 
the selected units of measurements in a csv text file. 

This file is easily imported in spreadsheet programs. 
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Capture Serial Data 
If WeatherMaster is communicating with the weather station over a serial 
connection, the sensor data can be captured and saved as a CSV file.  

 

 

 

To capture the sensor data click Capture Serial Data under Data. 

The sensor data will be displayed once per second for most systems. 

Click Browse to choose where to save the data.  

Click Start Capture to save the data to the CSV file.  

Click Stop Capture to stop the process.   
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Operation 

Main Screen 

 

The Main screen presents the main parameters clearly, using large text 
and a graphical wind dial.  

The yellow band along the wind dial is a graphical representation of the 
30 Second Vector Mean and Standard Deviation Wind Direction. 

Note: For a MicroServer type station the yellow band only displays with 
firmware version 2.8.10378 and higher. Also, the 30 Sec Rolling VM 
Wind Dir and the 30 Sec Rolling Std Dev Wind Dir need to be selected. 

Next to the timestamp a counter shows how long-ago data was received 
in seconds. If data is not received for more than 15 seconds the counter 
value turns red and continues to count. This counter is displayed on both 
the Main and Auxiliary tabs. The counter resets when switching between 
tabs.  

This screen is defined using an HTML file that can be customized at the 
factory. 

To print the screen, select Print from the File menu list. 
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Auxiliary Screen  

 

The Auxiliary screen displays the current values for temperature and rain 
parameters and other auxiliary sensors. The Auxiliary screen also 
displays the 1 Hour Vector Mean Wind reading for speed and direction 
including the wind direction standard deviation.  

Rain values are displayed for the day, week, month, and year. 

Other custom sensor values or parameters can be added to this screen. 
Please contact the factory for any customization requirements. 

To print the screen, select Print from the File menu list. 
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Trend Screen 

 

The Trend screen displays a 24-hour graph of the selected 
measurements. 

The graph will display the 24-hour data from 12:00 AM to the current 
time. 

The graph is self-scaling based on the data values and the size of the 
graph window. 

To select a measurement, use the drop-down arrow in the Measurement 
field and select the desired measurement. 

To graph data for another day, use the drop-down arrow in the Date field 
and select the desired date from the calendar. 

To advance to the next/previous day, month or year highlight one and 
press up or down on your keyboard.  

To zoom in on an area on the graph, click and drag your mouse. Double-
click to resume to normal view.  

To print the graph, select Print from the File menu list. 
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Daily Statistics Screen 

 

The Daily Statistics screen displays averages, minimum and maximum 
values for several measurements including the time of occurrence for the 
selected day.  

To view the data for another day, use the drop-down arrow in the Date 
field and select the desired date from the calendar. 

To print the screen, select Print from the File menu list. 
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Monthly Statistics  

 

The Monthly Statistics screen displays averages, minimum and 
maximum values for several measurements including the time of 
occurrence for the selected day.  

To view the data for another month, use the drop-down arrow in the 
Month field and select the desired month from the calendar. 

To print the screen, select Print from the File menu list. 
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Latest Measurements 

 

The Latest Measurements screen displays the current measurement 
values in the selected units. 

To print the screen, select Print from the File menu list. 
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ALOHA Software Interface 
ALOHA (Area Locations of Hazardous Atmospheres) is software jointly 
developed by NOAA and EPA. This software is used to model and plot 
plumes of hazardous gases and chemicals by HazMat and Emergency 
Management teams. 

To predict how a pollutant cloud might disperse in the atmosphere, 
ALOHA needs information about weather conditions at the release site. 
WeatherMaster automatically transmits weather data in the ALOHA 
format every 30 seconds. 

WeatherMaster transmits the following data, also called SAM (Station for 
Atmospheric Measurements): 

ID = the station identification number 

VS = the vector mean wind speed, averaged over 5 minutes (in 
meters per second) 

WD = the vector mean wind direction, averaged over 5 minutes (in 
degrees true) 

SD = the standard deviation of the wind direction (in degrees) 

TA = the mean air temperature, averaged over 5 minutes (in °C) 

SP = the instantaneous wind speed (in meters per second) 

DI = the instantaneous wind direction (in degrees true) 

TI = the instantaneous air temperature (in °C) 

B = instantaneous SAM battery voltage (in volts) 

CHK = a checksum value 

Note: The weather stations do not measure battery voltage and therefore 
always transmit 0.00 volts for battery voltage. 

Interfacing ALOHA to WeatherMaster 
From the Configuration menu list in WeatherMaster, select Configuration. 

Check “Interface to ALOHA” to interface WeatherMaster with ALOHA 
(Area Locations of Hazardous Atmospheres) software. 

If there is more than one station installed, only the first station can 
interface with ALOHA. 
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Use the following procedure to successfully connect ALOHA to 
WeatherMaster: 

1. Close both ALOHA and WeatherMaster (if they are open). 

2. Open ALOHA software and click OK at the introductory window. 

3. Make sure a site location is defined in ALOHA. 

4. Minimize ALOHA window. 

5. Open WeatherMaster. 

6. After the station properties are read, wait for 30 seconds. 

7. In ALOHA, click on Setup/Atmospheric/SAM Station. 

 

8. Click Yes to communicate with the running application. 

9. Enter desired information in the “User Input for SAM Unit” 
window and click OK. 

10. Enter desired information in the “Cloud Cover and Humidity” 
window and click OK. 

11. Wait approximately one minute while the software programs 
interface.  

12. ALOHA will display the weather data from WeatherMaster. 
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13. WeatherMaster will show ALOHA Active in the status bar. 

 

Note: If ALOHA and WeatherMaster are not communicating 
WeatherMaster will show ALOHA Unavailable in the status bar and 
ALOHA will ask for a COM port when a SAM Station is selected. 

This problem occurs when the NOAA_32.dll file is located 
somewhere other than the Windows folder. This file should reside 
only in the Windows folder.  

Perform a search to verify that the NOAA_32.dll file only exists in the 
C:\Windows folder (or equivalent.) If other copies of the NOAA_32.dll 
are found, simply rename then to NOAA_32.tmp. 
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Database 
WeatherMaster uses a Firebird SQL format database to store weather 
data. 

Data collected from all weather stations is stored in the database on 1-
minute intervals. 

In addition, the software also stores the daily minimum and maximum 
values, and daily statistics. 

To open the database directly, please contact the factory for instructions. 
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Troubleshooting 
Debug Window 
To view the communication between the weather station and 
WeatherMaster, select the Debug menu item from the Help menu list. 

 

On the left side of the tool bar, WeatherMaster has an indicator bar 
showing the communication status. If the bar is blank, there is no 
communication between the weather station and the software. If the bar 
has a moving blue area, there is a communication stream between the 
two. 

To stop the data stream between the weather station and the software, 
click on the Stop (Esc) button. In some instances, it might take few 
seconds for the stoppage to occur. If the data stream does not stop, click 
on the button again. 

To resume the data stream between the weather station and the 
software, click on the Resume button. 

The data displayed will differ from one station type to another. 
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Incorrect Temperature Readings (Capricorn/Pegasus or 
Capricorn FLX Only) 
When used with Capricorn, Pegasus or Capricorn FLX weather stations, 
WeatherMaster has the capability of displaying four temperature 
readings. 

If the temperature reading is 255 °F (123.9 °C), the temperature 
sensor is not installed or has not been properly initialized in the 
Control Module. 

Verify that the temperature sensor is installed, and then perform the 
temperature sensor initialization procedure.  

Please refer to the Capricorn 2000EX, Capricorn FLX or Pegasus 
Weather Station User Manual for installation/initialization procedure. 
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User Support Information 

Technical Support 
Columbia Weather Systems, Inc. offers free technical support to users. 
Columbia Weather Systems, Inc. reserves the right to revoke this policy 
at any time and charge a reasonable fee per hour for phone support. 

For technical support: 

Phone: 1-503-629-0887 

Fax: 1-503-629-0898 

Email: support@columbiaweather.com 

Office hours are 8:30 AM to 4:30 PM Pacific Time, Monday through 
Friday. 

Software License 
This Software is protected by copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties. The 
Software is licensed, not sold. 

You may install and use one copy of the Software on the Computer. 

Limited Warranty 
COLUMBIA WEATHER SYSTEMS, INC. WARRANTS THAT, FOR A PERIOD 
OF NINETY (90) DAYS FROM THE DATE OF DELIVERY TO YOU AS 
EVIDENCED BY A COPY OF YOUR INVOICE OR RECEIPT, THE MEDIA ON 
WHICH THE SOFTWARE IS FURNISHED UNDER NORMAL USE WILL BE 
FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP. EXCEPT FOR 
THE ABOVE EXPRESS LIMITED WARRANTIES, COLUMBIA WEATHER 
SYSTEMS, INC. MAKES, AND YOU RECEIVE, NO WARRANTIES, EXPRESS, 
IMPLIED, STATUTORY, OR IN ANY COMMUNICATION WITH YOU; AND 
COLUMBIA WEATHER SYSTEMS, INC. SPECIFICALLY DISCLAIMS ANY 
OTHER WARRANTY INCLUDING THE IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
COLUMBIA WEATHER SYSTEMS, INC. DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR 
FREE. If this Software was purchased in the United States, the above exclusions 
may not apply to you since some states do not allow the exclusion of implied 
warranties. In addition to the above warranty rights, you may also have other 
rights, which vary from state to state. 



WeatherMaster 65 
 ________________________________________________________________________  

Columbia Weather Systems, Inc. 

Limitation of Liability 
IN NO EVENT WILL COLUMBIA WEATHER SYSTEMS, INC. BE LIABLE FOR 
ANY DAMAGE, WHETHER ARISING FROM TORT OR CONTRACT, 
INCLUDING LOSS OF DATA, LOST PROFITS, COST OF COVER, OR OTHER 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM OR 
ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY 
THEORY OR LIABILITY. THIS LIMITATION WILL APPLY EVEN IF COLUMBIA 
WEATHER SYSTEMS, INC. OR ANY AUTHORIZED DEALER OR RESELLER 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU 
ACKNOWLEDGE THAT THE LICENSE FEE REFLECTS THIS ALLOCATION 
OF RISK. If you purchased this program in the United States, the above limitation 
may not apply to you because some states do not allow the limitation or 
exclusion of liability for incidental or consequential damages. 

Remedies 
The entire liability of Columbia Weather Systems, Inc. and your exclusive remedy 
under the warranty provided herein will be, at the option of Columbia Weather 
Systems, Inc., to attempt to correct or work around errors, to replace the media, 
or to refund the purchase price and terminate this Agreement. This remedy is 
subject to return of the Software to Columbia Weather Systems, Inc. or to the 
Authorized Dealer or Reseller from whom it was obtained along with a copy of 
your invoice or receipt. 
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END USER LICENSE 
AGREEMENT 
The following legal agreement (“AGREEMENT”) is for the license of 
WeatherMaster Software (“SOFTWARE”) by Columbia Weather 
Systems, Inc. (“CWS”). 

1. SOFTWARE License 
This SOFTWARE is protected by copyright laws and international 
copyright treaties, as well as other intellectual property laws and treaties. 
The SOFTWARE is licensed, not sold. 

CWS grants a non-exclusive license to use the SOFTWARE as 
described in the product user manual. 

You may install and use one copy of the SOFTWARE on three (3) 
computers. All three copies may be used simultaneously. Additional 
licenses are available. 

2. Limited Warranty 
CWS WARRANTS THAT, FOR A PERIOD OF NINETY (90) DAYS 
FROM THE DATE OF DELIVERY TO YOU AS EVIDENCED BY A 
COPY OF YOUR INVOICE OR RECEIPT, THE MEDIA ON WHICH THE 
SOFTWARE IS FURNISHED UNDER NORMAL USE WILL BE FREE 
FROM DEFECTS IN MATERIALS AND WORKMANSHIP. EXCEPT FOR 
THE ABOVE EXPRESS LIMITED WARRANTIES, CWS MAKES, AND 
YOU RECEIVE, NO WARRANTIES, EXPRESS, IMPLIED, 
STATUTORY, OR IN ANY COMMUNICATION WITH YOU; AND CWS 
SPECIFICALLY DISCLAIMS ANY OTHER WARRANTY INCLUDING 
THE IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE. CWS DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR FREE. If this SOFTWARE was purchased in the United States, 
the above exclusions may not apply to you since some states do not 
allow the exclusion of implied warranties. In addition to the above 
warranty rights, you may also have other rights, which vary from state to 
state. 

3. Limitation of Liability 
IN NO EVENT WILL CWS BE LIABLE FOR ANY DAMAGE, WHETHER 
ARISING FROM TORT OR CONTRACT, INCLUDING LOSS OF DATA, 
LOST PROFITS, COST OF COVER, OR OTHER SPECIAL, 
INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PROGRAM OR 
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ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON 
ANY THEORY OR LIABILITY. THIS LIMITATION WILL APPLY EVEN IF 
CWS OR ANY AUTHORIZED DEALER OR RESELLER HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU 
ACKNOWLEDGE THAT THE LICENSE FEE REFLECTS THIS 
ALLOCATION OF RISK. If you purchased this program in the United 
States, the above limitation may not apply to you because some states 
do not allow the limitation or exclusion of liability for incidental or 
consequential damages. 

4. Export 
The SOFTWARE is subject to the United States export laws and 
regulations. You must comply with all domestic and international export 
laws and regulations that apply to the SOFTWARE. These laws include 
restrictions on destinations, end users and end use.   

5. Remedies 
The entire liability of CWS and your exclusive remedy under the warranty 
provided herein will be, at the option of CWS, to attempt to correct or 
work around errors, to replace the media, or to refund the purchase price 
and terminate this AGREEMENT. This remedy is subject to return of the 
SOFTWARE to CWS or to the Authorized Dealer or Reseller from whom 
it was obtained along with a copy of your invoice or receipt. 

6. Choice of Law and Forum 
This AGREEMENT shall be interpreted according to the law of the state 
of Oregon, and any action to enforce its terms shall be instituted in 
Oregon. 

7. ENTIRE AGREEMENT 
This AGREEMENT is the entire AGREEMENT for the SOFTWARE and 
supersedes the term of any purchase orders and any other 
communications or advertising with respect to the SOFTWARE. You 
acknowledge that there are no other prior contemporaneous 
understandings, promises, representations, or descriptions with respect 
to the SOFTWARE.  

8. Contact Information 
If you have any questions regarding this AGREEMENT or to request a 
refund please contact Columbia Weather Systems, Inc. 

5285 NE Elam Young Parkway, Suite C100 
Hillsboro, OR 97124 
503-629-0887 
info@columbiaweather.com   
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Reference 

Glossary 

Self-Aspirating Radiation Shield 
A device used to shield a sensor such as a temperature or humidity 
probes from direct and indirect radiation and rain while providing access 
for ventilation. 

Barometric Pressure 
The pressure exerted by the atmosphere as a consequence of 
gravitational attraction exerted upon the “column” of air lying directly 
above the point in question. 

Celsius Temperature Scale 
A temperature scale with the ice point at 0 degrees and the boiling point 
of water at 100 degrees. 

Dew Point 
The temperature to which a given parcel of air must be cooled at 
constant pressure and constant water-vapor content in order for 
saturation to occur. When this temperature is below 0°C, it is sometimes 
called the frost point. 

Fahrenheit Temperature Scale 
A temperature scale with the ice point at 32 degrees and the boiling point 
of water at 212 degrees. 

Global Radiation 
The total of direct solar radiation and diffused sky radiation received by a 
unit horizontal surface. Global radiation is measured by a pyranometer. 

Heat Index 
The heat index or apparent temperature is a measure of discomfort due 
to the combination of heat and humidity. It was developed in 1979 and is 
based on studies of evaporative skin cooling for combinations of 
temperature and humidity. 



WeatherMaster 69 
 ________________________________________________________________________  

Columbia Weather Systems, Inc. 

Pyranometer 
Measures the combined intensity of incoming direct solar radiation and 
diffused sky radiation. The pyranometer consists of a radiation-sensing 
element, which is mounted so that it views the entire sky. 

Relative Humidity 
Popularly called humidity. The ratio of the actual vapor pressure of the 
air to the saturation vapor pressure. 

Sea Level Pressure 
The atmospheric pressure at mean sea level, either directly measured 
or, most commonly, empirically determined from the observed station 
pressure. 

In regions where the earth’s surface pressure is above sea level, it is 
standard observational practice to reduce the observed surface pressure 
to the value that would exist at sea level directly below. 

Soil Moisture 
Moisture in the soil within the zone of aeration present in the soil pores. 
In some cases, this refers strictly to moisture within the root zone of 
plants. 

Solar Radiation 
The total electromagnetic radiation emitted by the sun. 99% of the suns 
energy output falls within the wavelength interval from 0.15 microns to 
4.0 microns, with peak intensity near 0.47 microns. About one-half of the 
total energy in the solar beam is contained within the visible spectrum 
from 0.4 to 0.7 microns, and most of the other half lies near infrared, a 
small additional portion lying in the ultraviolet. 

Wet Bulb Globe Temperature (WBGT) 
Is a composite temperature used to estimate the effect of temperature, 
humidity, and solar radiation on humans. 

Wind Chill 
That part of the total cooling of a body caused by air motion. 
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Unit Conversion 

Speed 
Kilometers per hour = 1.610 x miles per hour 

Knots = 0.869 x miles per hour 

Meters per second = 0.448 x miles per hour 

Feet per second = 1.467 x miles per hour 

Temperature 
Temperature in °C = 5/9 (temperature in °F - 32) 

Temperature in °F = (1.8 x temperature in °C) + 32 

Distance 
Millimeters = 25.4 x inches 

Centimeters = 2.54  x inches 

Pressure 
Millibars = 33.86 x inches of mercury 

Kilopascals = 3.386 x inches of mercury 

Pounds per square inch = 0.49 x inches of mercury 

Standard atmospheres = 0.0334 x inches of mercury 

Solar Radiation 
BTU/foot2 minutes = 0.00529 x watts/meter2 

Joules/centimeter2 minutes = 0.006 x watts/meter2 

Mega joules/meter2 day = 11.574 x watts/meter2 

Langleys/minutes = 0.00143 x watts/meter2 



WeatherMaster 71 
 ________________________________________________________________________  

Columbia Weather Systems, Inc. 

Tables and Formulas 

Wind Chill Chart 

In 2001, NWS implemented an updated Wind Chill Temperature (WCT) 
index. The change improves upon the former WCT Index used by the 
NWS and the Meteorological Services of Canada, which was based on 
the 1945 Siple and Passel Index. 

In the fall of 2000, the Office of the Federal Coordinator for 
Meteorological Services and Supporting Research (OFCM) formed a 
group consisting of several Federal agencies, MSC, the academic 
community (Indiana University-Purdue University in Indianapolis (IUPUI), 
University of Delaware and University of Missouri), and the International 
Society of Biometeorology to evaluate and improve the windchill formula. 
The group, chaired by the NWS, is called the Joint Action Group for 
temperature Indices (JAG/TI). JAG/TI's goal is to upgrade and 
standardize the index for temperature extremes internationally (e.g. Wind 
chill Index). 

The current formula uses advances in science, technology, and 
computer modeling to provide a more accurate, understandable, and 
useful formula for calculating the dangers from winter winds and freezing 
temperatures.  
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Wind Chill Equation 
WC = 35.74 + 0.6215 T -35.75(V0.16) + 0.4275 T(V0.16) 

Where: 

WC = wind chill temperature in °F 

V = wind velocity in mph 

T = air temperature in °F 

Note: Wind chill Temperature is only defined for temperatures at or 
below 50 degrees F and wind speeds above 3 mph. 

Heat Index 
Heat index is calculated using the following formula: 

HI= -42.379 + 2.04901523*T + 10.14333127*RH - .22475541*T*RH - 
.00683783*T*T - .05481717*RH*RH + .00122874*T*T*RH + 
.00085282*T*RH*RH - .00000199*T*T*RH*RH 

Where T is temperature in degrees F and RH is relative humidity in 
percent.   

HI is the heat index expressed as an apparent temperature in degrees F.   

 



WeatherMaster 73 
 ________________________________________________________________________  

Columbia Weather Systems, Inc. 

Heat Index look up table (printed for reference) 
 

 Temperature in °F 

RH 70 75 80 85 90 95 100 105 110 115 120 125 130 135 

0 64 66 73 78 83 87 91 95 99 103 107 111 117 120 

5 64 69 74 79 84 88 93 97 102 107 111 116 122 126 

10 65 70 75 80 85 90 95 100 105 111 116 123 131  

15 65 71 76 81 86 91 97 102 108 115 123 131   

20 66 72 77 82 87 93 99 105 112 120 130 141   

25 66 72 77 83 88 94 101 109 117 127 139    

30 67 73 78 84 90 96 104 113 123 135 148    

35 67 73 79 85 91 98 107 118 130 143     

40 68 74 79 86 93 101 110 123 137 151     

45 68 74 80 87 95 104 115 129 143      

50 69 75 81 88 96 107 120 135 150      

55 69 75 81 89 98 110 126 142       

60 70 76 82 90 100 114 132 149       

65 70 76 83 91 102 119 138        

70 70 77 84 93 106 124 144        

75 70 77 85 95 109 130 150        

80 71 78 86 97 113 136         

85 71 78 87 99 117 140         

90 71 79 88 102 122 150         

95 71 79 89 105 126          

100 72 80 90 108 131          
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Dew Point 
B = (Ln (RH/100) + ((17.2694*T) / (237.7+T))) / 17.2694  

Dew Point in °C = (238.3 * B) / (1-B)  

Where:  

RH = Relative Humidity 

T = Temperature in °C 

Ln = Natural logarithm 

B = Intermediate variable 

Evapotranspiration 
The 1982 Kimberly-Penman equation: 

ETx=(/(+))(Rn-G)+(/(+)) 6.43 Wf (es-ea) 

The Penman equation is known as a “combination equation” because it 
combines net radiation (the heat function) and advective energy transfer 
(the wind function) into one energy balance equation. 

Wet Bulb Globe Temperature (WBGT) Approximation 
The approximation used by the Australian Bureau of Meteorology does 
not take into account variations in the intensity of solar radiation or of 
wind speed, and assumes a moderately high radiation level in light wind 
conditions. 

Use of this approximation may lead to incorrect estimates of thermal 
stress, particularly in cloudy and windy conditions. Under these 
conditions the approximation is likely to lead to an overestimate of the 
stress. The approximation will also overestimate night-time and early 
morning conditions when the sun is low or below the horizon. 

The simplified formula is: 

WBGT = 0.567 x Ta + 0.393 x e + 3.94 

Where: 

Ta = Dry bulb temperature in (°C) 

e = Water vapor pressure (hPa) [humidity] 

The vapor pressure can be calculated from the temperature and relative 
humidity using the equation: 

e= rh/100 x 6.105 x exp (17.27 x Ta / (237.7 + Ta)) 
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Where:  

rh = Relative Humidity (%) 

Source: American college of Sports Medicine, Prevention of thermal 
injuries during distance running – Positon Stand. Med.J.Aust. 1984 Dec. 
876 
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